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1 Introduction 

1.1 Integris Behaviour Module 

The Integris Behaviour module gives schools and educators an effective tool for Managing Student 
Behaviour records.  This encompasses Positive, Negative and Neutral behaviour.  Users can 
easily record behaviour records for one or more students.  All users can view and edit student 
records and record additional details for suspensions, isolations/withdrawals and other incidents.    
 
A range of standard Behaviour reports, letters and advices are produced for easy stream lining of 
departmental policy.  Users can create their own customised Behaviour reports, letters and advices 
via the mail merge facility. The production of statistical reports on behavioural data is also 
obtainable. 
 
The creation of Individual Behaviour Plans is made straightforward.  It allows the user to select a 
directory in which to create a new document or select a file to link to the document.   Individual 
behaviour Plans and behavioural records can be exported and imported from one Integris School 
to another.  The module will also update the Lesson Attendance Module with details of 
suspensions and withdrawals. 
 

1.2 Key Features 

Integris Behaviour Module includes the following key features. 
 

 Enter a behaviour record of one or more students. 

 Record additional details for suspensions or isolation/withdrawals.  

 View behaviour history for a student. 

 Multi – student behaviour recording. 

 Displays totals for all behaviour types. 

 Produces summaries and statistical reports on behaviour data. 

 Create, view and maintain Individual Behaviour Plans. 

 Import and Export behaviour reports and totals between Integris schools. 

 Updates Lesson Attendance records for suspensions and withdrawals. 

 Facility to mail merge to school generated advices and letters. 

 The ability that allows users to log and maintain records of letters sent  

 Notify principal, parents and relevant staff of a behaviour incident via email. 

 The ability to change parameters to fit in with jurisdiction policies and school processes 
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2 Getting Started 

2.1 Adding the Behaviour Module 

The Behaviour Module is loaded into INTEGRIS using the Add Module function.  To install the 
module: 

 Select Control from the General sidebar. 
 

 From the Control window double-click Add Module. 
 

 
 

 The Add Module window appears. 
 

 
 

 Double click on Behaviour .lbr 

 A message should then appear advising that the module was loaded successfully:  

 
 

 Click OK. 
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2.2 Logging on to Integris 

 Click on the Integris icon on the desktop.  

 The user login dialog box is displayed: 
 

 
 

 In the User Name field enter your user name. 

 Press the Tab key. In the Password field enter your password.  

 Click on Login or press Enter.  You will then be allowed access to the system. 

2.3 Locking/Minimising the Software on your Computer 

The software contains a function that enables users to lockout other users while away from the 
computer.  
To lock the software click on File > Lock Terminal or use the shortcut of  
<Ctrl> + <L>.  
 

 
 
To unlock it use the Unlock button.  
Enter your password when prompted. 
 

 
 
While Integris is locked, it is possible to access other applications by minimising Integris using the 

Minimise button in the top right corner of the screen.               

2.4 Accessing the Behaviour Module from Integris 

 Log on to Integris. 

 Click on the Behaviour button on the sidebar.  The functions within Behaviour are displayed on 
the sidebar. If you cannot see the Behaviour Tab in the sidebar, contact your Support Centre 
regarding installation of this module, (details of how to contact your Support Centre are shown 
on the back of this Manual). 
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3 Behaviour Sidebar Functions 
The Behaviour features of Integris are grouped on the Behaviour sidebar. 
 

 

 
Management – Student Behaviour record data entry point.  This 
allows for one or more students records to be entered.  Creation of 
Individual Behaviour Plans, standard or customised letters, reports 
and advices, Behaviour incident notification via email. 
 
Reports - Statistical Management reports for monitoring purposes. 
Standard Letters and exports that need to be sent to district office 
staff. 
 
Parameters - The Behaviour module will give users the ability to 
select and create their own codes to monitor and use in the 
management of student Behaviour Records. 
 
Utilities – The system provides the ability to import and export 
specified behaviour records between SIS schools and set defaults for 
template pathways, file storage, and Lesson Attendance 
suspension/withdrawal codes. 

 



 
 
 

The Behaviour Module and Lesson Attendance Links 

4 

 

                    Integris Behaviour Manual 
Behaviour 



 
IntegrisBehaviourManual.doc 11-Sep-14 

Page 4-2 

© 2014 Civica Education Pty Ltd 

 

 

4 The Behaviour Module and Lesson Attendance links 
When the Behaviour module is loaded all suspension and withdrawal information will be entered 
using this module.  Lesson Attendance records will be automatically updated if a suspension or 
withdrawal is added in the Behaviour module.  If a suspension or withdrawal needs to be changed 
or deleted this must be done in the Behaviour module.  Do not add suspensions or withdrawals, or 
make changes to them, using the Lesson Attendance module once the Behaviour module is in use.  
 
When a code is selected and a Behaviour record is entered this code will be used within Lesson 
Attendance to record or update their attendance records.  For instance if users chose the 
Attendance Suspension Code of  "Z" in system preferences, this will then be transferred to the 
Lesson Attendance Module and when viewing the students Attendance records of that period of 
time a "Z" will be recorded.  
 

 
 
In addition a comment will be added to the Lesson Attendance notes with details of the suspension 
created in the Behaviour module. 
 

 
 
 
In Lesson Attendance, version 2.2 and above, the suspension and withdrawal codes are 
unavailable for selection if the Behaviour module is in use.  It will not be possible to edit a 
suspension or withdrawal record created in Behaviour in these later versions of Lesson 
Attendance.  This will ensure the data for suspensions and withdrawals in both Lesson Attendance 
and Behaviour is synchronised. 
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4.1 Links to Lesson Attendance v12.00.00 (New Zealand Only) 

Note: This section applies to New Zealand users only. 

4.1.1 Updating of the Activity Log 

 
For New Zealand users only, whenever the Behaviour module automatically updates a marked 
attendance code (not ‘*’ or ‘?’) within Lesson Attendance v12.00.00, an entry is made in the activity 
log for each change.  The reason is automatically populated by the system with standard text in 
accordance with the following. 
 

Action  Reason text 

Marked attendance changed to the Attendance 
Stand Down Code by the Behaviour module 

‘Stood down via the Behaviour Module’ 

Marked attendance changed to the Attendance 
Withdrawal Code by the Behaviour module 

‘Withdrawn via the Behaviour Module’ 

Stand Down or Withdrawal behaviour record is 
edited to a different action within the Behaviour 
module  

‘Edited via the Behaviour Module’ 

Stand Down or Withdrawal behaviour record is 
deleted from within the Behaviour module 

‘Deleted via the Behaviour Module’ 

 
 
 

4.1.2 Calculation of Half-day Attendance 

 
The calculation of half-day attendance has changed in Lesson Attendance v12.00.00 and a new 
algorithm has been employed. The Behaviour module now uses this new algorithm when it 
instigates a re-calculation of the half day attendance.
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5 Behaviour System Preferences 
The Behaviour module stores the default settings in System Preferences.  There are two windows 
associated with Behaviour System Preferences: 
 
Within the Paths window users can set: 

 Default template for Individual Behaviour Plans 

 Default pathway for saving Individual Behaviour Plans 

 Default location for mail merge KST files 

 Default pathway for saving mail merge KST files 
 
Within the General window users can set: 

 Default codes for Lesson Attendance 

 Mandatory checks when entering student ‘Suspension’ 

 Default setting for ‘Retain on Transfer’ check 

 Default Position (Notice Letter) 

 Default email address when sending a Behaviour export file 

Note: Users will not be able to enter a behaviour record if System Preferences are not 
entered. 

5.1 Individual Behaviour Plan Pathways 

In some instances users may choose to create an Individual Behaviour Plan.  A Behaviour Plan 
can be created in association with a Behaviour record or independently.  When initiating the plan 
users are launched into a word template.  This template can be individualised by the user in word 
and linked to Integris.  Users must set up a default path to direct the storage of the document. 
 
 
To set the Individual Behaviour Plan Pathways: 

 Click on the Behaviour > Utilities icon.   

 Double click on System Preferences option.   

 The System Preferences window will be displayed. 

 Click on the Paths tab. 
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To set the path for the Default template document for individual behaviour plans: 

 Click on the  icon. 

 Navigate to the location of the selected template. 

 Select the desired template document.  

 Click on Open.  This will now set the pathway.  
 

To set up the Default pathway for merged individual behaviour plans: 

 Click on the  icon. 

 Navigate to the location of the selected folder. 

 Click OK. 
  

5.2 Mail Merge Letter Template (KST) File Pathways 

Users can set a default pathway for selecting a mail merge letter template (KST) and also a default 
pathway for storing their merged KST files. 
 
To set the Mail Merge KST File Pathways: 

 Click on the Behaviour > Utilities icon.   

 Double click on System Preferences option.   

 The System Preferences window will be displayed. 

 Click on the Paths tab. 
 
To set the path for the Default location KST template files: 

 Click on the  icon. 

 Navigate to the location of the selected folder. 

 Click OK. 
 
To set the Default saved path for merged *.KST files: 

 Click on the  icon. 

 Navigate to the location of the selected folder. 

 Click OK. 
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5.3 Default codes for Lesson Attendance 

To set the Default codes for Lesson Attendance:  

 Click on the Behaviour > Utilities icon.   

 Double click on System Preferences option.   

 The System Preferences window will be displayed. 

 Click on the General tab. 
 

 
 

5.3.1 Attendance Suspension code 

Note: for WA Schools the default Suspension Code should be set to Z. 

To set the Attendance Suspension code: 

 Use the drop down list and select Z. 

 Click OK to save this setting. 
 

5.3.2 Attendance Withdrawal Code 

Note: for WA Schools the default Withdrawal Code should be set to W. 

To set the Attendance Withdrawal code: 

 Use the drop down list and select W. 

 Click OK to save this setting. 
 

5.3.3 Authorised Absent Code 

The code that is selected here is used if a suspension or withdrawal is deleted, or if the negative 
action of a suspension or withdrawal is changed to some other action. 

Note: for WA Schools the default Authorised Absent Code should be set to / for Present. 

To set the Authorised Absent Code: 

 Use the drop down list and select / Present.  

 Click OK to save this setting. 
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5.4 Default setting for Retain all new Behaviour Records on Transfer 

Use the checkbox  to automatically set the  
check when adding a new Student Behaviour record. 
 

Note: for NT and NZ the default setting is automatically set to ticked. 

 

Note: for WA, if the Action selected is a Suspension then the ‘Retain on transfer’ check will 
always be ticked regardless of the default setting. 

5.5 Default Position (Notice Letter) 

Use this to enter the Default Position to appear on the Notice of Behaviour Incident letter. 
 

 
 
This will then appear by default in the Position field when generating a Notice of Behaviour Incident 
letter. 
 

 

5.6 Suspension/Exclusion Check 

Use this check to force the user to confirm whether any of the following actions have been 
whenever a student suspension is entered: 

 Notification to parent of intent to Suspend 

 Immediate suspension for serious breach 



 
IntegrisBehaviourManual.doc 11-Sep-14 

Page 5-6 

© 2014 Civica Education Pty Ltd 

 

 Discussion of suspension with parent/student 

 Letter of notification to parents 

 Letter of notification to student 

 Development of Behaviour Management Plan 

Note: The Suspension / Exclusion Check will be set to ticked by default. 

If this box is ticked then when attempting to save a student suspension the following dialog will 
appear: 
 

 
 
The user must check/uncheck at least one of the boxes in order to activate the OK button and save 
the record of suspension. 
 

5.7 Export Email Address 

 
When exporting a Behaviour data report, the user has the option to email the resulting CSV file. 
Use this field to enter a default email address for sending the export file to. 
 

 

Note: Export Email Address is not required for WA Schools. 

 
Close the Utilities window by clicking the cross on the top right hand corner. 
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6 Behaviour Parameters 
The Behaviour Parameters define the operation of the module.  There are a number of parameters 
that will be initialised with a set number of codes.   
 

 
 

6.1 Maintaining Parameters 

Use the Parameters functions to define the lists that users see when entering data.  

To access the parameters, click on the Parameters icon.   
 
Some Behaviour Parameters are pre-populated and may or may or may not be edited.  Behaviour 
Type, for example, contains 13 types all of which are locked and may not be edited.  Behaviour 
Sub Types however, may be added and edited by the school 
 
Before starting to use the system, you may need to set up the parameters you intend to use.  You 
can use the same procedure to set up many of the parameters used throughout Integris as they 
consist of a code, a school code and description.  Some will have been set up for the school.  
 
Each of the other parameters is set up using slightly different procedures dependent upon the 
information that needs to be held.  A separate section is given to each one later in this part of the 
manual. 
 

WARNING: Changing some Integris parameters will affect the integrity of the school’s data. 
Contact your Support Centre if you are unsure prior to changing any parameters.  (Details 
of how to contact your Support Centre are shown on the back of this Manual). 
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6.2 Adding/Editing Parameters – General Information 

 From the Behaviour Parameters window, double click on the icon for the parameter you want to 
update. 

 

 
 
The system displays the appropriate window.  The following is an example of Behaviour Type 
parameter set up in Behaviour Sub-Type. 
 

 Click Modify parameter descriptions and add parameters  

Note: To ensure Behaviour Sub Types are attached to the correct parent Behaviour Type, 
schools should check the Behaviour Type details first before adding. 

 Enter the new Behaviour Sub Type details 
 

 
 

 Click OK 
 
If the parameter is to be locked: 
 

 Highlight the Sub Type 

 Click Toggle Lock Status  
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 Click Yes  
 

 Repeat the above steps to create the further Behaviour Sub Types 
 

Note:  Editing options may also be accessed by right clicking on mouse.  Parameters may 
be selected and locked together. 

 

6.3 Printing a list of Parameters 

Clicking onto the Print Parameters icon  will produce a list of all the parameters.   

 

Example of the printed parameter report 
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6.4 Deleting Parameters 

 To delete a parameter click onto the Delete Selected Parameters icon   

 A confirmation message will appear. 
 

 
 

 Make the appropriate selection. 

Note: The deletion of a parameter that is in use can have an impact on the schools data file. 
Please contact your Customer Support Centre prior to deleting any Parameters. 

 

Note: Some parameters contain a value ‘Not Specified’. Do not change or delete any 
existing ‘Not Specified’ parameters. 

 

6.5 Toggle active property  

When you first set up your parameters, they are all active. If a school does not wish to use all of 
the parameters, a parameter can be made inactive, thereby switching it off, so it is not available to 
users. You can make an inactive parameter active again at a later date if required.  

Note: you can only make a parameter inactive if it is unlocked and if it is not being used. 

 

6.6 Making a Parameter Inactive 

When viewing a parameter list, click on the line/s that you wish to make inactive. 

 Click on the Toggle Active Property icon  or, right click on the parameter and select 

 from the menu. The system displays a message asking you to 
confirm this action. 

 Select Yes to proceed. The system reverses the “Active” state of the selected parameter/s. The 
value ‘No’ is shown in the Active column. 
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6.7 Lock Status 

Click on the Toggle Lock Status icon  or right click within the pane and click Toggle 
‘Locked’ status. Confirm that you wish to change the ‘locked’ status. The value in the Locked 
column changes to 'NO'. 
 
A confirmation message will appear.  Click the appropriate button. 
 

 
 

 To change the status back to ‘locked’, simply re-select the line and click on the Toggle Lock 
Status button. 

 

6.8 Defaults 

The Suspension Conditions parameters have the option to set a default when applying a 
suspension to a student record. 

 

 When viewing the parameter list, click on the line that you wish to make the default entry.  
 

The following example uses the Suspensions Conditions parameter:  “Specific permission must be 
gained to enter the school grounds.” 
 

 
 

 Click on the Toggle default condition icon . 
 

 A confirmation message will appear: 
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7 Behaviour Type 
 
The Behaviour Type parameter has a number of initialised codes.  Three of these are Positive, 
nine are Negative and one is a Neutral code. 
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8 Behaviour Sub-Type 
The Behaviour Sub-Type is linked to a Behaviour Type and allows schools to monitor different 
aspects of that particular behaviour type. 
 

 
 
The process of adding or modifying a Behaviour Sub-Type differs from that of other Behaviour 
Parameters as each new Sub-Type must be associated with an existing Behaviour Type.  
 
To add a new Sub-Type: 

 Click on the Modify parameter descriptions and add parameters icon.  

 The Add/Edit Behaviour Sub Type dialog will appear. 
 
 

 
 
 

 Enter the Sub-Type code (maximum 5 alphanumeric characters). 

 Enter the Sub-Type code Description (maximum 50 alphanumeric characters). 

 Select a Behaviour Type. 

 Click OK to Save. 
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To modify an existing Sub-Type: 

 Highlight the Sub-Type in the Behaviour Sub Type window and Click on the Modify 

parameter descriptions and add parameters icon.  

 Continue steps as for adding a new Sub-type. 
 

Note: There is no limit to the number of Sub-Types that can be recorded against one 
Behaviour Type. 
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9 Behaviour Actions 
The Behaviour Actions window is displayed below and shows the initialised codes for negative and 
positive behaviour. 
 

 
 
Currently the following Behaviour Action codes are provided and cannot be edited or deleted by 
the user. 
 

D Detention 
I Intention to Suspend 
L Loss of Privilege 
O Other 
R Reprimand 
S Suspended 
W Withdrawal 

n/s+ Not Specified 
n/s- Not Specified 
n/s= Not Specified 

 

Positive or negative Behaviour Actions may be added by the user. 
 

 
 
Users can set up as many default actions as they wish to appear on the Behaviour Details 
Report (see section 18.1.1) or the Individual Behaviour Report (see section 18.1.2). These need 
to appear as “YES” in the Report1 column. The toggling of Report Status can be done in two 
ways 
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 Highlight the action and click on the Toggle ‘Report1’ Status icon  or, right click on the 

parameter/s and select  from the menu. The system displays a message 
asking you to confirm this action. 

 Select Yes to proceed. The system changes the “Report” state of the selected parameter/s. 
The value ‘Yes’ is shown if the parameter is included in the default set. 

 
The Report2 column will allow a maximum of 7 actions to be selected and these values will default 
to any other reports using Behaviour Actions. This can be done in the same way as mentioned 

above, however selecting Toggle ‘Report2’Status  instead of ‘Report1’.  
 

Note: Once a maximum of 7 parameters have their ‘Report2’ status set to ‘Yes’ (including 
the three compulsory ‘Not Specified’ Behaviour Actions), you will not be able to set the 
‘Report2’ status of any other parameter to ‘Yes’.
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10 Notification Details 

 
 

The Notification Details default to those displayed in the report sample below.  
  

 
 
 
Refer to section 6 for details on how to modify or add behaviour parameters.
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11 Suspension Conditions 
The system comes with 2 active suspension conditions, both marked as default. 
 

 
 

Note: For WA schools do not delete any from the list. Additional suspension conditions can 
be added. Defaults can also be changed. 

 
Refer to section 6 for details on how to modify or add behaviour parameters.
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12 Location 
The Location parameter allows schools to monitor behaviour off site and at specific locations within 
the school grounds. 
 

 
 
Refer to section 6 for details on how to modify or add behaviour parameters.
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13 Management of Student Behaviour   

13.1 Student Behaviour Management Window Options 

Selecting the Management icon  from the Behaviour sidebar provides access to the Student 
Behaviour management data entry window. 
 
 
 
 

 

13.2 Finding Students 

 

Students can be found via the Find Student icon  or Search field.   

The cursor will default to the Search field on opening the window.  
 

13.2.1 Student Find Tool  

The student find tool operates in the same manner as within all other Integris Modules.  (For further 
details see the Administration Manager Manual)  
 

 
 

13.3 Print Student Behaviour Records  

Student records can be printed from this screen.  The Report that is generated will be the first entry 
in the Behaviour History Screen.  This will be highlighted by default when first entering the 
student’s record.  If another record needs to be printed, select the record required and then click 

Clear Browse 
Set 

Show only 
students with 
Behaviour 
Records 

Roll 
Status 

Previou
s 
Student 

Next 
Student 

Find 
Student 

Print 
Student 
Behaviour 

Send 
Letter 

Plan Create 
Customise
d Letter 

Send an 
Email 

View Main 
Student 
Details 

Add 
Student 
Behaviour 

Edit 
Student 
Behaviour 

Delete 
Student 
Behaviour 

Behaviour 
Sort 
Options 



 
IntegrisBehaviourManual.doc 11-Sep-14 

Page 13-3 

© 2014 Civica Education Pty Ltd 

 

the Print Student Behaviour icon.  All details pertaining to the particular record will be 
displayed in the report.  
 

 
Example of the Student Behaviour report 

 

 For multiple records hold the <Control> Key down and click on the desired selection.  An 
information message will appear detailing how many selections have been made. 

 

 

13.4 Send letter 

 
Refer to section 17.1 
 

13.5 Plan 

 
Refer to section 14. 

13.6 Create Customised Letter 

 
Refer to section 17.7 

13.7 Send an Email 

 
Refer to section 17.9. 

13.8 View Main Student Details 

Selecting the View Main Student details icon opens the Student details screen in read only 
mode. (See below). 
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Note: the user may not edit the student’s details, change to another student, add a new 
student or search for students from the Student Details window when accessed via the 
Behaviour module. 

 

 Click on the cross in the top right hand corner of the main Student details window to return to 
the Student Behaviour window. 

 

13.9 Roll status  

 

 
Student records are available for all rolls.  
 

 Admissions 

 Current 

 Former 

 External (if this is checked on in General>Control>Preferences) 
 

 Click onto the lookup menu and highlight the appropriate roll. 
 

13.10 Show only students with Behaviour Records  

This creates a browse set of only the students that have a Behaviour Record.    Once the 

browse set has been created the icon changes to reflect this.  
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 Click onto the Show only students with Behaviour records icon. 

 To release the browse set click onto the icon again and the browse set will be released. 
 

13.11 Behaviour Sort 

A drop-down box with a default to All (all Behaviour Types)   appears across the top of 
the toolbar.  This is used in conjunction with the Show only students with Behaviour records 
function (refer to section 13.10). 
 
The options for this drop-down are: 
 

All (all behaviour types) 
Negative (all behaviour types) 
Positive (all behaviour types) 
Neutral (all behaviour types) 

 

With the  - Show all students set the drop-down box will have no affect on which students are 
displayed. 
 

The  - Show students with Behaviour records only works together with the drop-down box 
as shown. 
 

Drop-down Box Setting 
 - Show students with 

Behaviour records only. 

 - Show all students. 
 

All (all behaviour types) Show students with Behaviour 
records only (any) 

Show all students. 

Negative (all behaviour types) Show only students with 
Negative Behaviour records. 

Show all students. 

Positive (all behaviour types) Show only students with 
Positive Behaviour records. 

Show all students. 

Neutral (all behaviour types) Show only students with 
Neutral Behaviour records. 

Show all students. 

 
 

13.12 Behaviour History 

 
 
Options within Behaviour History are: 
 

 Current Year – when this option is selected the Current Years records are displayed.  This will 
be for the current academic year that is set up within the Schools Diary. 

 All years - when this option is selected all records are displayed for the current and previous 
years. 

 
Users can filter this selection further by choosing the Behaviour Types and Actions.  The standard 
options are: 

 All 

 Positive Behaviour 

 Neutral behaviour  
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 Negative Behaviour 

 Detention 

 Intention to suspend 

 Loss of privileges 

 Other 

 Reprimand 

 Suspended 

 Withdrawal 
 
The list will also include any further Actions added by the user under Behaviour > Parameters > 
Behaviour Actions. 

13.13 Previous Schools Details 

 
 

Integris provides the ability to import and export specified behaviour records between Integris 
schools.  This transfer method transfers all student data, which includes Behaviour records.  The 
data transferred will include the behaviour report details for all reports where the ‘Retain for 
transfer’ flag has been set to ‘ Yes’ within Student Behaviour Management add mode.  
 
(For further details on Importing and Exporting Student Records refer to the Administration 
Manager Manual) 
 
Users have the option to include these records or not. If the records from a previous school are not 
required uncheck the tick box and they will not be displayed. 
 

 The details of the incident will be displayed in the Behaviour History section of the screen in grey.   
 

13.14 Suspensions and Withdrawal  

Totals are displayed below in the history list and are reflected in the current filter, which can be 
applied to the history list.  (This list will default to the current year – for all schools). 

 

 
 

For students joining the school after the start of the year their Behaviour information from other 
schools will only be available if it has been electronically transferred from another Integris School 
or retrospectively entered manually if received on paper. 
 

13.15 Student Photo 

Clicking on the camera  icon at the bottom of the behaviour management screen allows the 
user to view the student photo. 

13.16  Retrospective entry of student Behaviour Records 

To enter a student’s Behaviour record retrospectively.   

 Select the student’s records 

 Click onto the filter and select .  This will allow users to select the 
appropriate date for which the entry is to be made. 
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 Click onto the Add Student Behaviour icon   . 

  The Student Behaviour Add screen will appear. 
 

 
 

 The software allows users to enter directly into the Reported By field or by clicking on the Find 

Staff icon   to display a list of the current teaching staff to select from.  

 Users can enter the date into the Date field directly or choose to use the date selector. 
 

 
 
The Date Selector  

 
Single red arrows enable the user to scroll through months, while double red arrows are for 
selecting other years. The blue arrow takes the user back to the current date.  
 
Click on the appropriate date and select OK. The system enters the selected date into the date 
field. 
 

13.17  Adding a Student Behaviour Record 

Integris enables schools to hold a great deal of information about student Behaviour.   The 
Behaviour records entry window is used for both entry and maintenance of records.  The window is 

accessed by clicking on the Add Student Behaviour icon  or the Edit Student Behaviour 

icon   to the right of the history list on the Student Behaviour screen. To locate a Student 
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Behaviour Record use either the Search or the Find Student functions. (For details on how to use 
these functions refer to the Administration Manager Manual.)   
 

 
The student’s name will appear at the top left of the window, their Year and Form on the top right.   
 

 
 

The Reported By field  is where a teachers name can be 
recorded.  Two options are available to users are:   
 

 Type the Teacher’s name directly into the field or Click onto the Find Staff  icon.  This 
opens the Staff Selection List window.  The Staff List is drawn from Staff Details within 
Administration Manager. 

 

 
 

 Click on the Staff Member required. 

 Click OK. 
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This will place the teacher’s name into the Reported By field.  
 

 
 

13.18 Incident Number 

 
When adding a new Behaviour record, the next sequential Behaviour Incident number will 

automatically be generated.  
 
So that separate behaviour records may be linked, the Incident number can be edited to be the 
same as an existing Incident number.  
 

 Click on the Incident No. field and type the desired number.  

 If a number higher than the next sequential number is entered the following message will be 
displayed: 

 

 
 
The Incident number is displayed in the far right column (labelled ‘No.’) of the Behaviour History 
on the Student Behaviour window. 
 

 
 
 

13.19 Time of Behaviour Incident 

When adding a new Behaviour record, the current time is automatically recorded for Time of 

Incident.  The Time of Incident can be edited: 
 

 Click on the Time field and type the desired time (using the 24-hour clock).  

 If an invalid time is entered the record will not save when clicking OK. 
 

13.20 Location 

Users can record the location where the Behaviour incident took place. When adding a new 
Behaviour record by default the Location drop down list will be disabled and the Location will be 

set to ‘Not specified’.   The Location drop down list will 
be enabled once ANY Behaviour type is selected in the Behaviour field. 
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A Location can now be selected.  The Locations that are displayed in the list are generated from 
Behaviour Parameters.  (See section 6 - Behaviour Parameters) 
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13.21 Behaviour Type 

A Behaviour Type can now be selected.  The Behaviour Types that are displayed in the lookup 
menu are generated from Behaviour Parameters.  (See section 6 - Behaviour Parameters) 
 
The selections of Behaviour types that the system is initialised with are: 
 

 
 
The list will also include any Behaviour Sub-Types added by the user in Parameters.  
 
If a Behaviour Type has Sub Types displayed in the list, then the Behaviour Type Description will 
be displayed as bold.  If the Behaviour Type does not have Sub Types displayed in the list, then 
the font will remain normal (ie not bolded). 

 
 
If the Behaviour Type (or Sub-Type) is negative then an Action must be entered (see Section 13.22 
Action)  
 
An Action is optional for positive or neutral Behaviour types. A positive or neutral Behaviour record 
may be saved at this stage as there is no requirement to enter any further information. 
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13.22 Action 

 
Behaviour Actions are drawn from the Behaviour Parameters.  (See section 6 - Behaviour 
Parameters) 
 
If the Behaviour Type is Negative the Action menu will be populated with negative Actions only. 
 

 
 
If the Behaviour Type is Positive the Action menu will be populated with positive Actions only. 
 

 
 
If the Behaviour Type is Neutral the Action menu will be populated with neutral Actions only. 
 

 Select the Action required from the drop down list.    
 

 
 
 
If Suspended is the selected Action for a negative Behaviour Type then refer to section 13.23 - 
Suspensions for details on additional prompts and entry of information required. 
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13.23 Suspensions 

Suspension conditions only apply to Negative Behaviours.  If users enter details for a Suspension 
and then change the Behaviour Action the suspension information that has been added will be 
deleted. 
 

 
 

13.23.1 Default Suspension Conditions 

When a suspension is chosen users will be prompted if they would like to select the default 
suspension conditions: 
 

   
 
If Yes is selected the Suspension Conditions that were checked as a default in Parameters will be 
checked on.  
 
If No is selected the user has the option to select from the available Suspension Conditions by 
checking the required option. 
 

13.23.2 Suspension From and Until 

 
 

When Suspended is the selected Action, the From and Until fields need to be completed.  This is 
to record how long the Negative Behaviour Action will be enforced.  Users can enter the date 
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directly into the date field or use the date selector. (For details on how the use the Date Selector 
see section 13.16) 

 
If the date entry is invalid a warning message will appear describing the error date.  If the date is 
invalid the OK button will be greyed out, not allowing users to proceed with the entry. 
 

 
 

Note: the From and Until Fields can be used for all Behaviour Types. 

13.23.3 Suspension Period 

After a date range has been entered Integris allows users to enter the period in which a 
Suspension or Withdrawal is to be used. Users can enter the period the student is to commence 
the Negative Behaviour consequence and when the last Period of the consequence will be. 

 

 
 

The Last period of day is checked on when a From and Until date is selected.  
If you wish to change the selection and the student is returning on the same day uncheck the 
check box and an information message will appear.  
 

 

  
 

Enter the period that the student is returning. 

 

13.23.4 Suspension Date Overlap 

If users enter a suspension for the same day as an existing suspension then a Date overlap with 
Existing Incident Record warning will appear. 
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13.23.5 Suspension Total to date 

Suspensions are displayed as Total to date this school.  Details are also recorded for 
Withdrawals.  Withdrawals are totalled by occurrence.  The time is not indicated. 
 
Within suspensions the totals reflect how many suspension and how many days the student was 
suspended for within that particular suspension.     
These totals are accumulative.   

 

 
 

The totals are displayed in the history list and reflect the current filter applied to the history list (by 
default   ‘current year – all schools’).  If ‘All Years’ is chosen this will reflect in the totals displayed.  
 
Users have the option when entering a suspension to Retain on Transfer.   (See section 13.24 – 
Retain on Transfer) 

Special Considerations 

Total Days is derived from the From and Until dates or periods.  Records from a previous school 
can be incorrectly recalculated if the term structure or closure days differ between the current and 
previous schools.  Therefore records from previous schools or for a previous academic year cannot 
be edited.   To cater for errors, records from previous schools can be deleted, subject to users’ 
access rights.  (For details on users’ access rights refer to the Administration Manager Manual). 
 
For students joining the school after the start of the year their behaviour information from other 
schools will only be available if it has been electronically transferred from another Integris school or 
retrospectively entered manually if received on paper with the student’s records. 
 

13.23.6 Number of School Days (NT Schools Only) 

When run in NT mode, the Student Behaviour Add/Edit window will display an additional field for 
withdrawals and suspensions entitled ‘Number of School Days’ as illustrated below. 
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Using the ‘From’ and ‘Until’ dates entered by the user, the system calculates the number of days 
the school is open during this time, based on the school diary. 

Only school open days are counted. All days for which the school is closed (for any reason) are 
omitted from the calculation. 

There are no links between this new field and any other module (other than the school diary). 

The Periods chosen by the user on the Student Add/Edit window are not taken into account for this 
calculation. Any part of a day is counted as a whole day. 

The field is always displayed as a whole number of days (e.g. 3 days rather than 2.5 days).  

 

Note: This field is hidden for WA Schools. 
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13.23.7 Suspension/Exclusion Check 

When a record of suspension is saved the user is prompted with the following checks: 
  

 
 
The user must check/uncheck at least one of the boxes in order to activate the OK button and save 
the record of suspension. 
  

 

Note: for WA the checkboxes are automatically checked in the Letter to District Office (refer 
section 17.6) and therefore must be presented to the user for verification. (See example 
below) 

 
 
If the user edits the Behaviour record and selects another Action that is not a suspension, a dialog 
box with the following message will be displayed: 
 

 
 

 Click Yes to save the Action change.  

 The suspension checks will be cleared. 
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13.24 Retain on transfer 

Users have the option to choose to save a particular student record. 
This option allows users to retain a behaviour record when Importing and Exporting student 
behaviour records.  The default option is set in Behaviour > Utilities > System Preferences.       
 
If users require the record to be transferred via the electronic school to school transfer in the future 

then tick . 

Note: for WA schools this is defaulted to ticked on, for all suspensions. 

13.25 Appeal lodged against action 

Integris allows users to record if there is an appeal lodged against a Suspension. The function will 
only be enabled when a Negative Behaviour Type is selected. Once this is selected this option is 
made available. 
 
To record an appeal a check needs to be placed in the Appeal lodged against action checkbox. 
 

 

13.25.1 Appeal Date 

The date that the appeal was lodged must be entered.  This can be entered directly into the field or 
by using the Date Selector. 
 

13.25.2 Appeal Status 

The Status of the Appeal can also be selected.  Users can select from the lookup menu. 
 

 Not Specified 

 In Progress 

 Rejected 

 Successful 
 
Once the Appeal lodged against action is checked on the default selection of In progress is placed 
in Status. 
 

13.25.3 Appeal Details 

The Appeal Details tab also becomes active once the Appeal lodged against action checkbox 
has been selected. Details of the appeal can be entered. 
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13.26 Behaviour Details 

Once the fields that are required have been selected, if users have entered a Negative Behaviour 
Type of either Suspension or Withdrawal some text must be entered in the Behaviour Details 
section.   Each record has a free entry text (of up to 32000 characters) for the currently highlighted 
behaviour record. 
 
Users can cut and paste detail of Behaviour records from other applications such as Word.  Users 

can use the Edit functions on the top tool bar.   
Keyboard shortcut functions to copy and paste are, <Ctrl> + C to copy and <Ctrl> +V to paste. 
 

 

13.27 Action Details 

The Action Details field is for users to enter information regarding the Action taken for or during the 
recorded Behaviour incident.  This field is a free-entry text (of up to 32000 characters).  This is not 
a default screen and users can close the Behaviour record without entering any details into this 
screen. 
 

 
 

13.28 Notification Details 

The Notification Details screen allows users to select from a list of professionals that need to be 
notified about the particular Behaviour incident.  This list is drawn from Behaviour Parameters.  (To 
add or edit the list see section 6 - Behaviour Parameters). 
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Once a record has been created the selection list will only display what was selected initially.    
 

 

13.29 Suspension Conditions 

Note: the label for this tab will vary according to jurisdiction. 
 

NT NZ UK WA 

Re-entry Conditions Stand Down Conditions FT Exclusion Conditions Suspension Conditions 

 
Suspension Conditions can be set as a default in Suspension Condition Parameters.  One or more 
of them may be applicable to the current suspension.  Suspension Conditions marked as default 
will automatically be offered on selecting the Suspended action (see Section 13.23.1 - Default 
Suspension ). 

 

 
 

13.30 Log  

Functionality is available to record and save behaviour letters created for the student. Refer to 
section 17.8 for details. 

13.31 Additional Behaviour Types 

The user may enter additional Behaviour Types to associate with a particular behaviour record. 
For example if a student used an illicit drug and then vandalised a class room, the main Behaviour 
Type would be drug abuse but associated Behaviour types may be vandalism, abuse to staff and 
abuse to other students.  
 

 Click on the Additional tab. 

 A full list of Behaviour Types and Behaviour Sub-Types as specified in Behaviour Parameters 
is displayed. (Sub-Types are shown as indented in the list). 
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 Tick the checkbox for each additional Behaviour Type or Behaviour Sub-Type required.  
 

 
 

13.32 Response 

The user has the ability to record whether the parent/guardian has responded to the Behaviour 
advice sent. 
 

 Click on the Response tab. 

 Tick the Parent Response checkbox. 

 The free text field becomes active. 

 Enter details on the Parent response. 
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13.33 Multi-student Behaviour recording 

A Behaviour record can be created for a group of students in a current browse set.  The existence 

of a Subset is indicated by the Subset icon  changing from grey to red.   
      

13.34 Multi-student Entry 

Users can record a Behaviour Record for multiple students.   
 

 Users need to select the students through the Find Student tool . 

 Create the Browse set. 

 Click on the Add Student Behaviour  icon.  

 A selection message will appear. 
 

 
 

 To record the details for the browse set of student click . 

 A Group Behaviour Warning Message will appear. This is a reminder that students selected 
may have different Period Structures and therefore each record should be checked at the 
conclusion of the Add process to ensure any period differences between students are catered 
for. 
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 The number of students in the selected subset will be displayed at the top of the Student 
Behaviour Add screen and the Subset indication icon will change from grey to red.  
 

 
 

 To view the students’ names in the subset, click onto the View students in browse set icon 

. 

 This will display a list of student’s names. 
  

 
 
When the details have been entered a Student Behaviour Add Status, Behaviour Save Log will 
be displayed. 
   

 
 

 Click Close to close the log. 

 The Group Behaviour Warning message can then be closed 
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13.35 Editing Behaviour Records 

 To edit a Behaviour record, select the record that requires editing.  
 

 Click onto the Edit Student Behaviour icon .  This will open up the Student Behaviour 
Edit window and allow users to make adjustments. 

 Any changes that users make to a Student Behaviour Record for either a Suspension or 
Withdrawal will also be reflected in the Lesson Attendance Module.   

Note: Records imported from another school or external system cannot be edited and a 
message will be displayed. 

 
 

13.36 Editing a Behaviour Record from a Previous Year 

A user granted the access rights to Edit Previous Year Records will be able to edit any behaviour 
incidents which were entered prior to this academic year. 

Note that any changes to the From and Until dates of suspensions for previous schools or 
previous years will not affect any attendance data within Integris. Attendance data will need 
to be manually modified to ensure that it accurately reflects the student’s attendance at the 
school. 

On selecting a record from a previous year and clicking on the edit icon  the following 
message will be displayed: 
 

 
 
Click Yes to continue to edit the record or No to cancel. 
 

13.37 Display Behaviour Records from Previous School 

  
Users may wish to view Students details from a previous school.   This option is set as the default. 

 
 
Records from a previous school will be displayed in grey. 
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If the records do not need to be displayed then remove the tick in the Display Behaviour 
Records from Previous School check box and the previous school records will no longer be 
displayed. 
 

 

13.38 Deleting a Behaviour Record 

Users who have Administrator access rights are able to delete either the student’s complete 
behaviour history or an individual behaviour record. 
 
To delete the records: 
 

 Highlight the selected record(s). 

 Click on to the Delete Student Behaviour  icon. 

 A confirmation message will appear. 
 

 
 

 Selecting Yes will remove the record(s). 
 
Once a student’s records have been deleted they will no longer appear in the Show only students 
with Behaviour Records if this function is selected. 
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14 Creating an Individual Behaviour Plan 

 
 
In some instances users may choose to create an Individual Behaviour Plan.  A Behaviour Plan 
can be created in association with a Behaviour record or independently.  When initiating the plan 
users are launched into a word template.  This template can be customised by the user in word 
and placed into Integris.  Users must set up a default path to direct the storage of the template. 
 
If this path is not set, users will see a prompt asking them to establish the pathway.  
 

 
  

14.1 Set Up of Individual Behaviour Plan Template 

For template creation, users will need to create their own, for instance in Word. To include student 
details, three fields can be bookmarked within the template. 
 

14.2 Bookmarks for Student details 

The Behaviour Module is designed to populate three bookmarks in the Behaviour Plan template 
(i.e. Microsoft Word document). The names of the bookmarks need to match the following: 
 
StudentName 
PlanDate 
ReviewDate 
 
Users can create their own template and include these bookmarks in any location as desired and 
the Behaviour Module will replace these bookmarks with the relevant information.  
 
Users can still create a template without any of these bookmarks and use the Behaviour Module to 
create the plan for students. In this instance the Behaviour Module will not populate the information 
as described above. 

 

When the users have created a template this will need to be placed in a folder in a shared location.  
This will allow for the creation of a default path.  
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14.3 Adding an Individual Behaviour Plan to a student behaviour record 

 To access the Individual Behaviour Plan function click onto the Plan icon  
 
The Student’s First Name and Legal Surname will appear on the top task bar. Note that the Legal 
Surname and First Name are drawn from Student Details. 
 
The options available in the Individual Behaviour Plan appear in the top tool bar. 
To add a new behaviour Plan: 

 Click onto the Create New Plan  icon. 
 
The Add Individual Behaviour Plan window will be displayed and several fields will need to be 
completed: 
 

 Date Created – this will default with today’s date. 

 Document Name – For example this could be the student’s first initial and surname. 

 Document Path- this is set in the System Preferences (see section - Setting the pathway for the 
‘Default template document for individual behaviour plans’.) 

 Review Date – A future date when the plan should be reviewed. 
 

 Once these have been entered click OK. 
 

Note: If the Document path is not set correctly warning messages will be displayed 
prompting users to set these in the System Preferences. 

 

 
 

 
 

 

 If the pathways have been set correctly the Individual Behaviour Plan template will launch and 
be displayed on the bottom toolbar displaying the document name the user entered.  The fields 
that have been bookmarked (see section 14.2 - Bookmarks for Student details) will be 
populated.  These are Student Name, Plan Date and Review Date.    
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14.4 Editing an Individual Behaviour Plan Name 

 To edit the details for a Behaviour Plan, such as the Review date or Entry date; 
 

 Highlight the entry you wish to edit. 

 Click on the Edit Plan  icon. This will open the Edit Individual Behaviour Plan window. 
 

 
 
The only details that can be changed are the Date Created and the Review Date. 
 
Enter the new details. 
 

 Click OK. 
 

14.5 Linking an Individual Behaviour Plan or other Word document 

Users can link an existing Individual Behaviour Plan or other related document that have been 
created previously.  The document needs to be saved into the Behaviour folder.   This creates a 
record of the document and allows users to view and edit directly from the Behaviour Module. 
  
To link this document: 

 Click on the Link Plan icon  on the Individual Behaviour Plan toolbar. 
 

 
 

 Click on the  icon to navigate to the saved Word file location.  

 Select the required document. 

 Click Open.  

 This will now be recorded in the Link Individual Behaviour Plan document Path. 
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 Click OK 
 

Linked documents can be launched, viewed and edited via the Edit Plan Details icon.  
 

14.6 Deleting Individual Behaviour Plans 

In the event that users wish to delete an Individual Behaviour Plan reference or the plan document: 
 

 Select the document that you wish to delete. 

 Click on the Delete Plan icon . 

 A message will be displayed: 
 

 
 

 Click Yes to remove the plan references. 
 

 
 

 Click Yes to delete the reference and the document from the Behaviour Plan folder. 

 Click No and this will only delete the reference to the document. 
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14.7 Edit an Individual Behaviour Plan details 

Once an Individual Behaviour Plan has been created users may wish to edit the details.   
To edit the document: 
 

 Highlight the reference. 
 

 

 Click on the Edit Plan Details icon . 

 The document will be launched. 

 Make the required changes. 

 Save the changes. 
 

14.8 Printing an Individual Behaviour Plan   

 Select the Behaviour Plan you wish to print.   

 Click on the Print Plan  icon. 

 This will send the plan directly to the printer. 
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15 Importing and Exporting of Behaviour records 
Integris provides the function to import and export specified behaviour records between Integris 
schools and import behaviour records from other systems. 
 
The data transfer will include the behaviour report details for all reports where the ‘retain for 
transfer’ flag is set to ‘yes’.  This would include all data, including the additional suspensions and 
withdrawal information but with the exception of reporting staff member name, the Notification 
comments. 
 
There are two methods of importing student behaviour records: 
 

15.1 Integris School to School Transfer Method 

Student behaviour records are transferred within the standard School-to-School Import and Export 
functions. If a student is moving to a new school and their records are to be exported, their 
behaviour records will be transferred also. For further details refer to the Administration Manager 
Manual. 
 

15.2 Import Behaviour Data from an external system 

The Import Behaviour Data from an external system is a utility that imports data from another 
system in a csv format.  To be able to import the data some pre conditions need to be met. 
  

1) The import file is a comma separated value file (i.e. csv). 
2) The Behaviour codes and Action codes in the import file will be compared with the existing 

Behaviour Codes, if there is a successful match the details will be added to the student. If the 
match is unsuccessful the description will be checked and details will be added to the student 
using the existing codes. 

 

15.3 Fields available for Import 

 

 Student Ref (SIS Ref No.) 

 Student Surname 

 Student First Name 

 Date Recorded 

 Reported by (first name surname) 

 Behaviour Code  (SIS code) 

 Action Code  (SIS code) 

 Behaviour Details text 

 Action Details text 

 From Date 

 To Date 

 No. Days Suspended 
  
The last 3 would only be for actions that were suspensions. 
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15.4 Mandatory import fields 

The following fields are mandatory. If data for any of the following fields is not specified, the system 
will report an error and the record will not be imported. The user will be required to correct the 
errors, revalidate the data, and if there are no errors, complete the import. 
 
1) Student Ref 
2) Surname  
3) Firstname 
4) Date recorded 
5) Behaviour code 
6) If  an Action code of Suspended (s) exists then from date, to date and total days suspended 

are mandatory 
 

15.5 Validation Rules 

The following rules will apply when validating the imported data. 
 
1) Behaviour code 
The imported behaviour description will be compared with the existing behaviour description. If 
there is a successful match the description of the imported behaviour code and description will be 
set to the existing behaviour code and description.  
For example if the imported behaviour code was ‘N4’ (Verbal abuse or harassment of staff) and the 
existing code was ‘N2’ (Verbal abuse or harassment of staff), the imported code ‘N4’ would be 
transferred to the existing one ‘N2’ on the student’s record. 
If there is not a successful match the record will be imported and set to the existing behaviour code 
‘N9’ (Negative Behaviour – other). 
 
2) Action code 
The imported action code will be compared with the existing action code. If there is a successful 
match the description of the imported action code and description will be set to the existing action 
code and description.  
 
For example if the imported action code was ‘L’ (Loss of privilege) and the existing code was ‘A’ 
(Loss of privilege), the imported code ‘L’ would be transferred to the existing one ‘A’ on the 
student’s record. 
 
If there is not a successful match the record will be imported and set to the existing action code 
‘n/s=’ (Not specified). 
 
If the action code is ‘S’ then the ‘from’ date, ‘until’ date and ‘no of days suspended’ must be 
provided. Otherwise an error will be generated and the import process terminated. 
 
3) Student Ref (SIS Ref No) 
The Student Ref number must match an existing Integris student reference number. Otherwise an 
error will be generated and the import process terminated. 
 
4) Surname 
The Surname in the import file will be compared to the surname in the database and the user 
warned if there is a mismatch. This will be regarded as a warning only, and the import will continue. 
 
5) First name 
The First name in the import file will be compared to the first name in the database and the user 
warned if there is a mismatch. This will be regarded as a warning only, and the import will continue. 
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6) Date Recorded 
The date recorded cannot be a future date. Otherwise an error will be generated and the import 
process terminated. 
 
7) From and Until date 
The ‘from’ date recorded cannot be a future date and has to be earlier than the ‘until’ date. 
Otherwise an error will be generated and the import process terminated. 
 

15.6 Importing behaviour data from an external system 

 Once the pre conditions have been met and the csv file is ready for importing open 
Behaviour>Utilities. 

 Double click on Import Behaviour data from an external system. The Behaviour Incident 
Import window will be displayed. 

 

 
 

 Click on the Select Import file icon.  

 Navigate to the import file location. 

 Select the import file and click OK. 
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 Select the imported data to be validated and click on the Validate button. 
 

 If any validation errors occurred a warning message will be displayed: 
 

 
 

 View the Import Log for any validation errors that need rectifying. For example: 
 

 
 

 If no errors occurred the Import button will become active.  

 Click the Import button and the selected correctly validated records will be imported. 

 A log of the import can be printed by clicking on the Print Import Log button. 
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16 Behaviour User Access Rights 
Each user account has an accompanying set of access privileges that need to be activated.  The 
way in which these are set, defines the parts of the system to which each user is allowed access. 
 
To set the user access rights for Behaviour a user would need the appropriate level of access to be 
able to set up and manage user accounts if this is available: 
  

 From the General sidebar select the Control icon. 

 Double click on Users  

 Double click on the User Name of the user whose privileges you wish to set. Alternatively, click 

once on the appropriate User Name and then click on the Set User Access Rights icon . 

 The system displays the Access Control window, showing a list of the modules your school 
uses.    

 Each installed module on your system is represented by a folder on the tree at the left-hand 
side of the window. 

 Select the Behaviour folder by clicking on the Folder to the left of the word Behaviour. 
 

  
 

 Whether or not a specific facility of the module is accessible by the selected user is defined by 
the presence of a “Y” or an “N” in the access column. In the example below, the user does not 
yet have any access Delete Behaviour records. 
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 You need to set up access rights to each component of the system you want the user to be 
able to access. Each folder in the access control tree contains a list of components of the 
module. 

 
For further information on setting user access rights refer to the Administration Manager Manual. 
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17 Behaviour Letters, Advices and Emails 
The production of Suspension Notices for the District Office is available through the Reports menu, 
as for other Behaviour Management Reports. All other letters, advices and the email functionality is 
available from the Student Behaviour Management screen.  
 

17.1 Send Letter Function 

The send letter function is available by clicking on the Send Letter icon  in the Student 
Behaviour window. 
 
The type of letter or advice option provided will depend on the type of behaviour selected. 
 
 For a positive behaviour type the options provided are: 
 

 Internal School Advice-Behaviour Incidents and Commendations 

 Commendation Letter 2 
 
 
For a negative behaviour type other than a suspension the options provided are: 
 

 Internal School Advice-Behaviour Incidents and Commendations 

 Notice of Behaviour Incident 

 Suspension Considered 
 
For a suspension the options provided are: 
 

 Internal School Advice-Behaviour Incidents and Commendations 

 Notice of Behaviour Incident 

 Suspension Notice 
 
For a neutral behaviour type the option provided is: 
 

 Internal School Advice-Behaviour Incidents and Commendations 
 
 To access the letters and advices: 
 

 Select a single behaviour record 

 Click on the Send Letter icon.  

 The Select Letter/Advice window is opened. 

 Select the letter or advice required. 
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 Click OK 

 Complete the printing options (this will depend on the type of letter or advice selected.) 

 Select the report destination 
 
 

17.2 Internal School Advice- Behaviour Incidents and Commendations 

 
In the Behaviour Management screen select the student for whom you wish to produce a letter or 
advice. The Internal School Advice- Behaviour Incidents and Commendations can be used for 
Behaviour Incidents of any type.  Its intention is to produce a hard copy, which is distributed within 
the school. 
  
To print out the Advice: 
 

 Select the record for which the letter or advice applies. 

 Click on the Send Letter icon.  

 The Select Letter/Advice window is opened. 

 Select the Internal School Advice-Behaviour Incidents and Commendations. 

 Click OK. 

 Select the referring Staff Member, this can be typed in directly or use Find Staff  icon to 
access the Staff list. 

 Enter the Letter date by either entering the date in directly or using the Date Selector. 

 Click Print.  
 

 
 

 Users then have the option to preview or send the document to the printer. 
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Example of Internal School Advice
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17.3 Commendation Letter Two 

The Commendation Letter can be used for any Behaviour Incident with a Positive Behaviour Type. 

 To generate the advice enter the Positive Behaviour then select the Send Letter icon.   

 Select Commendation Letter 2 from the Select Letter /Advice window. 
 

 
 

 Click OK 
 

 
 
Users can then select the following options: 
 

 Stationery Options – plain paper or Pre-printed Stationery. 

 Select Letter Destination – the default will be Send letter to all marked as Family Mail Marker. 

 Select Signing Staff member  

 This field can be reselected by using the  icon.  Alternatively type the appropriate name or 
Position directly into the field.  

 Select the Senior Staff Member using the  icon.  

 This field can be reselected by using the  icon.  Alternatively type the appropriate name or 
Position directly into the field.   

 Enter the Date of the Letter by either typing it in directly or using the Date Selector.  The default 
date will be the current date. 
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Example of Commendation Letter Two 
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17.4 Suspension Considered Advice 

When the Intention to Suspend action is selected, a Suspension Considered advice can be 
generated to notify the parents/guardian of the student’s impending suspension.   
 

 To generate the advice enter the action Intension to suspend and then select the Send 

Letter icon.   

 Select Suspension Considered from the Select Letter /Advice window. 
 

 
 

 Click OK 
 
Users can then select the following options: 
 

 Stationery Options – plain paper or Pre-printed Stationery. 

 Select Letter Destination – the default will be Send letter to all marked as Family Mail Marker. 

 Select referring Staff member – this field defaults with the Principal’s name.  This field can be 

reselected by using the Find Staff  icon.  Alternatively type the appropriate name or 
Position directly into the field.  

 Select the Contact Staff Member using the Find Staff  icon.   

 Type the Position of the Contact Staff Member e.g. Teacher. 

 Enter the Date of the record by either typing it in directly or using the Date Selector.  The 
default date will be two school days after the current date. 

 The schools telephone number is the default. If another telephone number is required this can 
be directly typed into the field. 

 The Letter date will default to the date at the time of creating the letter. 

 Users then have the option to preview or send the document to the printer. 
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Example of Intention to Suspend Letter 
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17.5 Notice of Behaviour Incident 

The Notice of Behaviour Incident is available for any Behaviour Incident with a Negative Behaviour 
Type. 

 To generate the advice enter the Negative Behaviour and then select the Send Letter icon.  

 
 Select Notice of Behaviour Incident from the Select Letter /Advice window. 
 

 
 

 Click OK. 

 The Notice of Behaviour Incident window will be displayed: 
 

 
 
User can select the following options: 
 

 Stationery Options – Plain paper or Pre-printed Stationery. 

 Select Letter Destination – the default will be Send letter to all marked as Family Mail Marker. 

 Select requesting Staff Member.  This field can be selected by using the Find Staff  icon. 
Alternatively type the appropriate Name and Position directly into the field.  

 Enter the Date of the record by either typing it in directly or using the Date Selector.  The 
default date will be the current date. 

 Click Print. 

 Users then have the option to preview or send the document to the printer. 
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Example of Notice of Behaviour Incident Letter
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17.6 Suspension Notice 

This Letter is available for any Behaviour incident with a Negative Behaviour Type and with a 
suspension action. 
 

 To generate the advice enter the Negative Behaviour and Action Suspended then select the 

Send Letter icon.   

 Select Suspension Notice from the Select Letter /Advice window. 
 

 
 

 Click OK 

 The Suspension Notice window will be displayed. 
 

 
 
Users can then select the following options: 
 

 Stationery Options – plain paper or Pre-printed Stationery. 

 Select Letter Destination – the default will be Send letter to all marked as Family Mail Marker. 

 Select Referring Staff member – this field defaults with the Principal’s name.  This field can be 

reselected by using the  icon.  Alternatively type the appropriate name or Position directly 
into the field.  

 Select the Contact Staff Member using the  icon.   

 Type the Position of the Contact Staff Member- Teacher. 

 Enter the Date of the record by either typing it in directly or using the Date Selector.  The 
default date will be two school days after the current date. 
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 The schools telephone number is the default. If another telephone number is required this can 
be typed directly into the field. 

 The Letter date will default to the date at the time of creating the letter. 

 Click Print. 

 Users then have the option to preview or send the document to the printer. 
 

 
Example of Suspension Notice Letter
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17.7 Create Customised Letter 

The Create Customised Letter function utilises the KST mail merge letter facility familiar to Integris 
Users. 
 

17.7.1 Creating a Behaviour KST Template 

To create a KST template to mail merge student behaviour information into: 
 
Start > Microsoft Word 
 

 Select File > Open 

 Navigate to C:\keys\INTEGRIS\MMTPL\LETTERS 

 Select Files of Type All Files 

 Double click on BEHAVIOUR.KST (See example below) 

Note: This document lists all school related, student related and behaviour related fields 
which can be used when creating a mail merge letter from within the Behaviour module.  
Fields can be copied and pasted into a letter template. 

RM Management Solutions 
Behaviour Management Mailing Fields  

  

11 September 2014 (note – this is a Word Date field. It can be used in your letter templates) 

Field Name  Displays Notes 

Known Name(UK)  <KnownName>  

Preferred Name(Australia)  <PreferredName> 

First Name  <FirstName> 

Second Name  <SecondName>  

Surname  <Surname>  

Legal Surname  <LegalSurname>  

DOB  <DOB>  

Age  <Age>  

Year/Class (UK)  <Year/Class>  

Year/Form (Australia)  <Year/Form> Student Details 

Class (UK)  <Class>  

Form (Australia)  <Form>  

Class Tutor 1(UK)  <Tutor1>  

Class Tutor 2(UK)  <Tutor2>  

Form Teacher 1(Australia)  <Teacher1>  

Form Teacher 2(Australia)  <Teacher2>  

Year  <Year>  

SEN Stage  <SENStage>  

House  <House>  

Ethnicity (UK)  <Ethnicity>  

Indigenous Status 
(Australia) 

 <Indigenous Status>  
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Religion  <Religion>  

Mother Tongue  <MotherTongue>  

Previous School  <PrevSch>  

Entry Date  <EntryDate>  

Destination School  <DestSch>  

Leave Date  <LeaveDate>  

CentrisID  <CentrisId>  

Reference  <Reference>  

UPN  <UPN>  

ExamCandNo (UK)  <Exam No.>  

Student No. (Australia)   <Student No.>  

Email  <Email>  

Phone 1  <Phone1>  

Student Address (Line)  <StuAddressLine>  

Student Address (Block)  <StuAddressBlock>  

Student Address (Split)  <StuAddShortBlock> 

<StuAddTown> 

<StuAddCountyState> 

<StuAddPostcode> 

<StuAddCountry> 

Student Address details 

He/She  <He/She>  

he/she  <he/she>  

His/Her  <His/Her>  

his/her  <his/her> Gender derived fields 

Him/Her  <Him/Her>  

him/her  <him/her>  

Boy/Girl  <Boy/Girl> 

Male/Female  <Male/Female> 

boy/girl  <boy/girl> 

male/female  <male/female> 

son/daughter  <son/daughter> 

Doctor  <Doctor>  

Medical Practice  <Practice>  

Practice Address (Block)  <Practice Address> Medical Details 

Practice Phone 1  <Practice Tel1>  

Practice Phone 2  <Practice Tel2>  

Practice Fax  <Practice Fax>  

Dentist’s Name  <Dentist>  

Dental Practice  <Dental Practice>  

Dental Practice Address  <Dental Practice 

Address> 

 

Dental Practice Telephone  <Dental Practice Tel>  

Permission to Call Doctor 
(Yes/No) 

 <Permission Call Doctor>  

Permission to Administer 
First Aid (Yes/No) 

 <Permission First Aid>  
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Permission to Call Dentist 
(Yes/No) 

 <Permission Call Dentist>  

Medical Condition 1  <Med Con 1>  

Medical Condition 1 
Emergency Notes 

 <Med Con 1 Notes>  

Medical Condition 1 
Flagged status (Yes/No) 

 <Med Con 1 Flagged>  

Medical Condition 2  <Med Con 2>  

Medical Condition 2 
Emergency Notes 

 <Med Con 2 Notes>  

Medical Condition 2 
Flagged status (Yes/No) 

 <Med Con 2 Flagged>  

Medical Condition 3  <Med Con 3>  

Medical Condition 3 
Emergency Notes 

 <Med Con 3 Notes>  

Medical Condition 3 
Flagged status (Yes/No) 

 <Med Con 3 Flagged>  

Medical Condition 4  <Med Con 4>  

Medical Condition 4 
Emergency Notes 

 <Med Con 4 Notes>  

Medical Condition 4 
Flagged status (Yes/No) 

 <Med Con 4 Flagged>  

AddresseeName  <AddeeName>  

AddresseeInitials  <AddeeInitials>  

AddresseeFirstName  <AddeeFirstName>  

AddresseeSurname  <AddeeSurname>  

AddresseeSalutation  <AddeeSalutation>  

AddresseeTitle  <AddeeTitle> These fields are updated when “Send  

AddresseeAddress (Block)  <AddeeAddress> to Family Mail Marker” is selected. 

AddresseeAddress (Split)  <AddeeAddShortBlock> 

<AddeeAddTown> 

<AddeeAddCountyState> 

<AddeeAddPostcode> 

<AddeeAddCountry> 

 

ConName1  <ConName1>  

ConInitials1  <ConInitials1>  

ConFirstName1  <ConFirstName1>  

ConSurname1  <ConSurname1> . 

ConSalutation1  <ConSalutation1> 1st Contact as displayed in contacts 

ConTitle1  <ConTitle1> list on the student browse window. 

(Contacts are displayed in 

Emergency order) 

ConAddress1 (Block)  <ConAddress1>  

ConAddress1 (Split)  <ConAdd1> 

<ConAdd1Town> 

<ConAdd1CountyState> 

<ConAdd1Postcode> 

<ConAdd1Country> 

To produce details for other contacts change 

the “1” in the field name to the appropriate 

number e.g. <ConName2> 

ParName1  <ParName1>  
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ParInitials1  <ParInitials1>  

ParFirstName1  <ParFirstName1>  

ParSurname1  <ParSurname1> . 

ParentSalutation1  <ParSalutation1>  

ParentTitle1  <ParTitle1>  

ParentAddress1 (Block)  <ParAddress1> Parent/Guardian 1 Details 

ParentAddress1 (Split)  <ParAdd1> 

<ParAdd1Town> 

<ParAdd1CountyState> 

<ParAdd1Postcode> 

<ParAdd1Country> 

 

ParName2  <ParName2>  

ParInitials2  <ParInitials2>  

ParFirstName2  <ParFirstName2>  

ParSurname2  <ParSurname2> . 

ParentSalutation2  <ParSalutation2>  

ParentTitle2  <ParTitle2>  

ParentAddress2 (Block)  <ParAddress2> Parent/Guardian 2 Details 

ParentAddress2 (Split)  <ParAdd2> 

<ParAdd2Town> 

<ParAdd2CountyState> 

<ParAdd2Postcode> 

<ParAdd2Country> 

 

Behaviour Type Code  <BehTypeCode>  

Behaviour   <Behaviour>  

Behaviour Sub type  <BehSubType>  

Behaviour Sub-Type 
Description 

 <BehSubDesc>  

Behaviour Action  <Action>  

Behaviour From Date  <From Date>  

Behaviour To Date  <Until Date>  

Behaviour From Period  <From Period>  

Behaviour To Period  <To Period>  

Behaviour Details  <Details>  

Behaviour Action Details  <Action Details>  

Behaviour Total Days  <Total Days>  

Behaviour Suspension 
Days 

 <Suspension Days>  

Behaviour Reported By  <Reported By>  

Behaviour Notification  <Notification Details>  

Behaviour Appeal Status  <Appeal Status>  

Behaviour Appeal  <Appeal>  

Behaviour Report Date  <ReportDate>  

Behaviour Time  <Time>  

Behaviour Additional Sub 
Types 

 <AddSubTypes>  

Behaviour Location  <Location>  
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Behaviour List of 
Suspension Conditions 

 <Suspension Conditions>  

School Address  <SchoolAddress>  

School Address (Split)  <SchoolAdd> 

<SchoolAddTown> 

<SchoolAddCountyState> 

<SchoolAddPostcode> 

<SchoolAddCountry> 

 

School Name  <SchoolName>  

District Name (Australia)  <DistrictName>  

Head Teacher Name (UK)  <HeadTeacherName>  

Principal Name (Australia)  <PrincipalName>  

Head Teacher Title (UK)  <HeadTeacherTitle>  

Principal Title (Australia)  <PrincipalTitle>  

Head Teacher Salutation 
(UK) 

 <HeadTeacherSalutation>  

Principal Salutation 
(Australia) 

 <PrincipalSalutation>  

LEANo (UK)  <LEANo>  

District (Australia)  <DistrictNo>  

DfESNo (UK)  <DCSFNo>  

School Number (Australia)  <SchoolNo>  

LEACode (UK)  <LEACode>  

District Code (Australia)  <DistrictCode>  

Exam Centre Number (UK)  <ExamCentreNo>  

School Type  <SchoolType>  

School Control  <SchoolControl>  

Curriculum Group  <CurricGroup>  

Intake Year  <IntakeYear>  

Leavers Year  <LeaverYear>  

Maximum Intake  <MaxIntake>  

Number on Roll  <RollCount>  

Telephone 1  <TelNo1>  

Telephone 2  <TelNo2>  

Fax  <Fax>  

School E-Mail Address  <SchEmail>  

 

 

 Open a New Blank Document in Word  

 Insert the school logo by navigating to Insert > Picture > From File and navigating to the 
location of a school logo on your network and choose Insert 

 Insert the date by selecting Insert > Date and Time, select the format  

 Create the letter template (an example is provided below) copying and pasting the relevant 
fields from the BEHAVIOUR.KST document 

 If any of the merge fields are not in the same font as the rest of the letter then change them 

 Choose File > Save 

 Navigate to C:\keys\INTEGRIS\MMTPL\Letters 

 Enter the file name “INSERT FILE NAME.kst” (it is VERY IMPORTANT that the file name 
includes the quotation marks and the .kst file extension) 
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 Close the Word document 

 Close the .kst document 
  
 

17.7.2 Utilising the Create Customised Letter Function 

Once a behaviour KST template has been created and saved the Create Customised Letter 
function can be utilised with the template for mail merging individual or groups of student behaviour 
records into letters. 
 
To create a customised letter or advice: 
 

 Click on Behaviour > Management. 

 Select a Student and highlight a relevant Behaviour record. 

 Click on the Create Customised Letter icon.  

 The Mailing Options window will open. 
 

 
 

 If required, tick the Send to all Contacts marked as Family Mail Marker. (The default to Send to 
all Contacts marked as a family mail marker check is un-ticked and in this case the letter will 
only be sent to the specific parent/guardian whose merge fields are included into the KST 
template).  

 

Note: this checkbox should only be checked if the ‘Addee’ fields are included in the KST 
template that will be used for the merge. 

 

 Click OK to proceed, or Cancel to exit the Custom letter creation process. 

 You will be prompted to Select a letter template (KST file). The default path for Behaviour 
KST files is defined in Behaviour > Utilities > System Preferences > Paths. 
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 Select the required template. 

 Data defined in the KST merge fields will be extracted from the highlighted behaviour record 
and saved in a WORD document created from the template. The name of the WORD 
document will be formed from the KST filename, date and time. The default path for saving the 
WORD document is defined in Behaviour > Utilities > System Preferences > Paths 

 

 
 
 
 

 Click OK 
 
The window will navigate to the default behaviour letter template location (Refer to section 5.2 for 
set up.) 
 

 Double click on the desired KST behaviour letter template 
 

 
 

 Click on OK to proceed. 
 
You will be prompted whether to send details of the letter to the Student’s Behaviour log.(Refer to 

section 17.8) 
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 Click Yes if you wish to save details of the letter to the Student’s Behaviour Log.  
 

 
 

 The letter will merge with the student information  

 The merged letter will be displayed on the bottom toolbar 
 
 

17.7.3 Creating Customised Letter for Multiple Behaviour Records 

The following output will occur when multiple behaviour records are selected: 
 

 When a single student is selected and multiple behaviour records are highlighted, a letter will 
be created for each incident (record). All letters will be stored in the one document. 

 

 If a browse set of students is selected, a letter will be created for the latest Behaviour incident 
recorded for each student. All letters will be stored in the one document. 

 The letters will merge with the student information  

 The merged letters will be displayed on the bottom toolbar 
 
If the letter has been logged this can be viewed in the Behaviour Log tab. 
 

 
 
To view a logged letter: 
 

 Highlight the hyperlink for the letter and double click to open 
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17.8 Log Letters 

When Letters are produced from the Behaviour module the user is given the option to save details 
of the letter in the Behaviour Log. 
 

  
 
After producing the letter the following dialog is displayed: 
 

 
 

 Click Yes to record the details of the internal letter sent. 

 The date and name of the letter will be stored under the ‘Log’ tab of the Student Behaviour 
Management window. 

 
For customised letters, the name will reflect the path and file name of the letter. To view a 
customised letter: 
 

 Double-click on the customised letter label. 

 The customised letter will open in MS-WORD. 
 

17.8.1 Deleting Log Files 

To delete a logged file: 
 

 Select the log file to delete: 
 

 
 

 Right click the mouse to bring up the following window  
 
The following message will be displayed: 
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 Click Yes to delete or No to cancel 
 
If Yes is selected the following message will be displayed 
 

 
 

 Click Yes to delete the physical document or No to cancel 
 
If Yes is selected the following message will be displayed: 
 

 
 

 Click OK 
 

17.9 Send an Email 

The Behaviour module can send an email or emails with attachments. 
 
To send an email: 
 

 Click send an email icon  

 In the To field either type an email address directly in the field or click on the To icon  to 
locate any related email addresses to the student record. 

 If using the To icon the associated email addresses will be retrieved e.g.: 
 

 
 

 Select the email address(s)  (additional addresses can be selected by holding the <Ctrl> key) 

then click the Back icon  

 Type a subject in the Subject field e.g. Intention to Suspend 

 Click on the Message tab to enter a message 



 
IntegrisBehaviourManual.doc 11-Sep-14 

Page 17-23 

© 2014 Civica Education Pty Ltd 

 

 
 
To attach files: 
 

 Click on the Attached Files tab 

Click on  and navigate to the file location. E.g. 
 

 
 

 Click Send 
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17.10 Suspension Notice – District Office  

This Suspension Notice - District Office is available from the Behaviour > Reports menu in the 
Letters Folder.  Users are required to input a date range into the View Suspensions List Criteria 
section.  The report will include all suspensions commencing within the date range.   
 

 
  

 Open the Behaviour – Reports by clicking on the Reports icon on the Behaviour sidebar. 

 Click on the Letters folder and select the Suspension Notice – District Office. 

Note: the dates entered in the From Date and Until Date fields relate to the incident dates of 
suspensions. 

 Enter the range of incident dates. 

 Place a tick in the box next to Display Suspension list over Date Rage for specific letter 
selection. (This produces a Suspension Letter Selection List – see below. If the tick is left off, 
all of the Suspension Notices will automatically be generated for the selected incident date 
range.) 

 Enter the Letter date. 

 If required, place a tick in the box next to Include Behaviour Sub-Type information 

 Click Print. 

 The following screen will be displayed if Display Suspension list over Date Rage for specific 
letter selection was selected: 

 

 
 

 Select the students a Suspension Letter – District Office needs to be generated for and click 
OK. 
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 Users then have the option to preview or send the document to the printer. 
 

Note: the checkboxes under ‘Actions taken in terms of this suspension’ are automatically 
populated from the Suspension/Exclusion checks presented when saving a suspension. 

 
 

 
Example of Notification to District Office



 
 
 

Reports 

18 

 

                    Integris Behaviour Manual 
Behaviour 
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18 Reports 
The Behaviour Reports can be accessed by clicking on the Reports icon on the Behaviour Sidebar. 

 
Four folders are available which include: 
 

 Management Reports (Refer to section 18.1) 

 Letters (Refer to section 17.7) 

 Exports (Refer to section 0) 

 Custom Reports (Refer to section 18.4) 
 

 
 

18.1 Management Reports 

The Management Reports consists of a number of standard reports that schools can produce to 
view either individual behaviour records or statistical comparisons. 
 

The Reports that are available are: 
 

 Behaviour Details – The intention of this report is to provide the stored behaviour incident 
details and actions for a selected student(s) in a hard copy report. 

 Individual Behaviour Report – The intention of this report is to provide full details of selected 
behaviour incidents for a student (s) on a one page per incident basis. 

 Student Suspensions Summary – The intention of this report is to provide details of 
suspensions for selected students(s) from a historical perspective. 

 Behaviours – Statistical Overview- the intention of this report is to provide a comprehensive 
statistical overview of the behaviour details held for selected students and groups for a given 
data range. 
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 Suspensions – Statistical Overview – This report is similar to Behaviours – Statistical 
Overview but is based solely on those behaviours that have resulted in confirmed suspension 
actions. 

 School Summary – Number of Suspensions – This report shows the number of suspensions 
for each Year group and gender.  The report also shows the number of suspensions for each 
suspension category. 

 School Summary – Number of Times Suspended - This report provides a breakdown by 
Year and Gender of the number of students, and the number of times they have been 
suspended.  

 Suspension Status - This report provides information for suspensions that are in progress for 
the specified date.  It displays the student’s name, year, suspension start date and end date, 
the number of days the suspension is for and the date the student will return to school. 

 Detention Statistical Overview – This report will provide a comprehensive statistical overview 
of the number of detentions on a period by period basis for a selected student or group within a 
given date range. 
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18.1.1 Behaviour Details Report 

The Behaviour Details report is available for any Behaviour type.   
 
Within the report it refers to the referring staff member and the date that the report was generated.  
Details that are included in this report are: 
 

 Student Name  

 Year Group  

 Form 

 Reporting Date Range 

 Date Incident Reported 

 Type/Sub Type 

 Location 

 Reported By 

 Action (-, + or =) 

 Behaviour Details 

 Action Details 

 Suspension Details will appear if the incident has been recorded as a suspension. 
 
The Main title can be tailored to the user’s needs and individualised page footer can also be 
inserted. 
 
Users can select to have a page per student. This is the default setting.  If this is not desired 
uncheck this option. 
 

 
 
The Options tab allows for the selection of an Incident Reported Date range: 
 

 From and Until 
 
The primary sort options are: 

 Surname 

 First Name 

 Year  

 Form  

 Gender 

 Reported by 

 Location 
 
The secondary sort options are: 

 Date 

 Behaviour Type 
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The Student Selection tab allows users to select the students they wish to generate the report for. 
 

 
 
The options available are: 
 

 Student Find - when the student Find option is required uses can access the student search 

window by clicking on the Add Students  icon.   

 To delete a particular student selection click on the Remove Students  icon. 

 To delete the student list click on the Remove All Students  icon. 
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 Form – to select all forms click on the Select All  icon and this will highlight all forms.  If 
users wish to make a random selection hold down the <Ctrl> key and select the required forms. 

 Year Group – to select all Year Groups click on the Select All   icon and this will highlight 
all Year Groups.  If users wish to make a random selection hold down the <Ctrl> key and 
highlight the required Year Groups. 

 Group – select the Group Type, and then highlight the group required. 
 

 
 

 Teaching Set – select the Year Period and Subject. To select all Teaching Sets click on the 

Select All  icon. 
 

 
 
The Behaviour Type(s)/ Action(s) tab allows users to select the Behaviour Type(s) and Action(s) 
that will be reported on.  The defaults are: 
 

 Behaviour Types - all 13 default Behaviour Types as defined in Behaviour > Parameters > 
Behaviour Types. 

 Actions – all default Behaviour Actions as defined in Behaviour > Parameters > Behaviour 
Actions with Report1 status set to Yes. 
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 To deselect a Behaviour Type, uncheck the relevant checkbox. 

 To deselect an Action uncheck the relevant checkbox. 
 
For example, if only negative Behaviour Types are checked and the only Action unchecked is 
‘Suspended’ then the Behaviour Analysis Report will only display records for Negative Behaviour 
incidents where the Action is NOT suspended. 
 
To print the report: 
 

 Click on the Print button. 
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An example of a Behaviour Details Report 
 

18.1.2 Individual Behaviour Report 

The intention of this report is to provide the full details of a selected behaviour incident for a 
selected student or students on a one page per incident basis. 
 
Details that are included in this report are: 
 

 Student Name 

 Year Group 

 Form 

 Student Photo (optional) 

 Reported By 

 Date 

 Incident Number 

 Time of Incident 

 Location 

 Behaviour Type (Sub-Type)   

 Action (and period of suspension if applicable) 

 Behaviour Details 

 Action Details 

 Notification Details 

 Appeal Details  

 Suspension Details 

 Additional Details 

 Parent Response 
 

To select the students for this report, users can access the Find Tool by the  
button.  When the selection is made this information will be displayed in the cell adjacent. 

.   
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The Incident Reported Date can be entered either directly or by using the date selector. 
 

To display the Student Photo on the Individual Behaviour Report tick the  checkbox. 
 
The Behaviour Type(s) tab allows users to select the Behaviour Type(s) that will be reported on.  
The Default is all selections are checked on. 
 
The Action(s) tab allows users to select the Action(s) that will be reported on.   
The Default Actions for reporting are defined in Behaviour > Parameters > Behaviour Actions.  
These are activated by the YES option for Report1 in Parameters.  
 
To select or deselect any of these options, click into the adjacent box.  
 
To print the report: 
 

 Click on the Print button. 
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Example of Individual Behaviour Report 
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18.1.3 Student Suspensions Summary 

 
This report will provide details of a suspension for a selected student or students from a historical 
perspective. 
 

 
 
Included details are: 
 

 Selected criteria 

 Date range 

 Student name 

 Year 

 Form 

 Date 

 Number of days of suspension 

 Behaviour Type (Sub-Type) Code 

 Brief Details of Incident 

 Reporting Teacher 

 Total number of suspensions 

 Total days of suspension within the date range.  
 

This report allows users to determine what criteria they would like to report on. The Main title can 
be tailored to the user’s needs and individualised page footer can also be inserted. 
 
The Options tab allows users to select the incident reported date 

 Enter a  'From and Until' date range 
 
Primary Sort options are available: 
 

 Surname and First Name (default sort fields)   
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Other options are: 

 Year 

 Number of Times Suspended 

 Form 

 Gender 
 

The Secondary Sort options are: 

 Date (default) 

 Behaviour Type 

 Teacher 
 

 
Additional Constraints: 

 Minimum number of Suspensions   

 Minimum number of days Suspended 
 
 
Secondary Sort: 

 Date 

 Behaviour Type 

 Teacher 
 
The Student Selection tab allows users to select which students or student group the report is to 
be generated for.   
 

 
 
The options are: 
 

 Student Find 

 Form 

 Year Group 
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Student Find 

When the student Find option is required, users can access the find tool by clicking on the Add 

Students  icon.   

 To delete a particular student selection click on the Remove Students  icon. 

 To delete the student list click on the Remove All Students  icon 
 

Form  

To select all forms click on the Select All  icon and this will highlight all forms.  If users wish to 
make a random selection hold down the <Ctrl> key and highlight the required forms  
 
 
This can be filtered by Group Type. 

To select all groups click on the Select All  icon and this will highlight all groups.  If users wish 
to make a random selection hold down the <Ctrl> key and highlight the required forms 
 

Year Group 

 

To select all forms click on the Select All  icon and this will highlight all forms.  If users wish to 
make a random selection hold down the <Ctrl> key and highlight the required forms 

Behaviour Type(s) 

The tab required users to select a particular negative Behaviour Type.  The default setting has all 
negative Behaviour Types on the list selected.     
 
To deselect an item, click into the check box. 
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To print the report: 
 

 Click onto the Print button  
 
 

 
Example of Student Suspensions Summary Report 

18.1.4 Behaviours – Statistical Overview 

This report will provide a comprehensive statistical overview of the behaviour details held for a 
selected student or group within a given date range. 
 
Details included are: 

 Selection criteria 

 Name  

 Year  

 Form 

 Behaviours – Positive: 
 
 1 – Significant positive behaviour or major award 
 2 – Merit or good behaviour award (often via assembly recognition) 
 3 – Other positive behaviour 
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 Negative: 
 
 1 – Physical assault or intimidation of staff 
  2- Verbal abuse or harassment of staff 
 3- Physical assault or intimidation of other students 
 4-Verbal abuse or harassment of students  
 5- Wilful offence against property 

6- Violation of school code of Conduct, behaviour management plan, classroom or school 
rules 

 7- Substance misuse 
 8- Illegal substance offence 
 9- Other (negative behaviour)  

 Other codes 
Actions – codes: 

S - Suspension 
D - Detention  
I – Intention to suspend 
L – Loss of privilege 
O – Other 
R – Reprimand 
W- Withdrawal 
   

 Totals - are given on an individual student bases and accumulative for example over a Form or 
Year group.  The totals for each student are displayed alongside the student's name.  The 
accumulative totals and averages are displayed at the end of each group and for all selections 
at the end of the report. 

 

 Averages are calculated to one decimal place. 
 
For example if the Total=3, this is divided by the total number of students in the selection e.g. if 
there were 14 students selected the calculation would be 3 divided by 14 = 0.2 (Rounded to 1 
decimal place). 
 

 A number of options for displaying totals and averages can be selected. The default is to 
include individual student information.  If this is not required, click into the check box. 
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 Code Key - provides description for all behaviour types and actions. 
 

 
 

On the Student Selection tab users can select the required students or group. 
 

.  

 
The options are: 
 

 Student Find 

 Form  

 Year Group 
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Student Find 

 When the student search option is required uses can access the find tool by clicking on the Add 

Students  icon.  

 To delete a particular student selection click on the Remove Students  icon. 

 To delete the student list click on the Remove All Students  icon. 
 

Form 

To select all forms click on the Select All  icon and this will highlight all forms.  If users wish to 
make a random selection hold down the control key and highlight the required forms  
 

Year Group 

 To select all Year Groups click on the Select All  icon and this will highlight all Year Groups.  
If users wish to make a random selection hold down the control key and highlight the required Year 
Groups. 
 

 
To print the report 
 

 Click onto the Print button. 
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West Coast District High School

Behaviours - Statistical Overview

Selection criteria:  Form - Room 4 Date Range: 10 October 2002 to 30 March 2003

Behaviours Actions

Year/FormName Sex
Positive Negative Other

1 2 3 Tot 1 2 3 4 5 6 7 8 9 Tot S D I L O R W
Albert Jackie 4/Room 4 F 2 2 4 1 2 3 6 2 4 3.0 1 1

Bailie Doyen 4/Room 4 M 1 1 1

Dunstan Jennifer 4/Room 4 F 1 1

Edwards Julie 4/Room 4 F 1 1

Farmer Kristof 4/Room 4 M 1 1

Gray Thi reth 4/Room 4 M 1 1

Jones Tim 4/Room 4 M 1 2 1 4 1 1 3 2 7 1 0.5 1 2 2 1

Marshall Kristy 4/Room 4 F 1 1

Moor Chris 4/Room 4 M 1 1

North Mathew 4/Room 4 M 1 1

Price Tiffani 4/Room 4 F 1 1

Sorrell Sarah 4/Room 4 F 1 1

Varricchio Kim 4/Room 4 F 1 1

Williett Elizabeth 4/Room 4 F 1 1

Totals 1 15 3 19 1 1 1 6 5 14 2 5 3.5 1 3 2 3

Averages 0.1 1.1 0.2 1.4 0.1 0.1 0.1 0.4 0.4 1.0 0.1 0.4 0.3 0.1 0.2 0.1 0.2

Final Totals 1 15 3 19 1 1 1 6 5 14 2 5 3.5 1 3 2 3

Final Averages 0.1 1.1 0.2 1.4 0.1 0.1 0.1 0.4 0.4 1.0 0.1 0.4 0.3 0.1 0.2 0.1 0.2

Bless this house Page 1

Produced on 19th February 2003 at 13:00 Behaviour > Reports > Management Reports. Behaviours - Statistical Overview

West Coast District High School

Behaviours - Statistical Overview

Selection criteria:  Form - Room 4 Date Range: 10 October 2002 to 30 March 2003

Behaviours
Positive Negative

Actions

1 P1 Signif icant positiv e behav iour or major award 1 N1 Phy sical assault or intimidation of  staf f S Suspended

2 P2 Merit or good behav iour award (of ten v ia assembly  recognition) 2 N2 Verbal abuse or harassment of  staf f D Detention

3 P3 Other positiv e behav iour 3 N3 Phy sical assault or intimidation of  other students I Intention to suspend

4 N4 Verbal abuse or harassment of  students L Loss of  priv ilege

5 N5 Wilf ul of f ence against property O Other

6 N6 Violation of  school Code of  Conduct, behav iour management plan, classro... R Reprimand

7 N7 Substance misuse W Withdrawal

Other Neutral behav iour 8 N8 Illegal substance of f ence

9 N9 Other (negativ e behav iour)  
Example of Behaviours – Statistical Overview report 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

18.1.5 Suspensions – Statistical Overview 
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The purpose of this report is very similar to the Behaviours – Statistical overview but is based 
solely on those behaviours that have resulted in a confirmed suspension action.  This report will 
not include the action of Intention to suspend. 
 
Included details are: 
 

 Selection criteria 

 Date Range 

 Name  

 Year  

 Form 

 Gender 

 Suspension Reasons 
 

1 – Physical assault or intimidation of staff 
  2- Verbal abuse or harassment of staff 
 3- Physical assault or intimidation of other students 
 4-Verbal abuse or harassment of students  
 5- Wilful offence against property 

6- Violation of school code of Conduct, behaviour management plan, classroom or school 
rules. 

 7- Substance misuse 
 8- Illegal substance offence 
 9- Other (negative behaviour)  
 

 Totals - are given on an individual student bases and accumulative for example over a Form or 
Year group.  The totals for each student are displayed alongside the student's name.  The 
accumulative totals and averages are displayed at the end of each group and for all selections 
at the end of the report. 

 

 Averages are calculated to one decimal place. 
 

 A number of options for displaying totals and averages can be selected. The default is to 
include individual student information.  If this is not required, click into the check box. 

 

 

 
 

 Code Key- provides a description of the suspensions. 
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On the second tab users can select the required students or group. 
 

 
 

The search options are: 
 

 Student Find (default) 

 Form 

 Year Group 

Student Find 

 When the Student Find option is required uses can access the find tool by clicking on the Add 

Students  icon.  

  To delete a particular student selection click on the Remove Students  icon. 

 To delete the student list click on the Remove All Students  icon. 

Form  
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To select all forms click on the Select All  icon and this will highlight all forms.  If users wish to 
make a random selection hold down the control key and highlight the required forms  
 

 

Year Group 

To select all Year Groups click on the Select All  icon and this will highlight all Year Groups.  If 
users wish to make a random selection hold down the control key and highlight the required Year 
Groups. 
 
 
To print the report: 
 

 Click on the Print button. 
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Example of Suspensions-Statistical Overview Report 
 

18.1.6 School Summary-Number of Suspensions 

The purpose of this report is to summarise the number of suspensions within the school.  It 
presents a whole school view, with a year and gender breakdown. 
 
Included details are: 
 

 Student selection - All students, Non-Aboriginal Students or Aboriginal Students.  Current Roll 
(default), Former Roll, External Roll, Admissions Roll. 

 Date Range 

 Gender totals – Male, Female 

 Year 

 Total for a year and gender group 

 Total of days suspended for each year and gender group 

 Overall totals for gender group and all selected 

 Code key 
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Note: For NT Schools an additional column will appear on this report entitled ‘Total Sch 
Days’. This summarises the data for the ‘Number of School Days’ field displayed on the 
Student Add/Edit window. See section 13.23.6 on page 13-15 for further details of this field. 

 
 
To print the report: 
 

 Enter the Selection option using the radio button (All students is the default) 

 Select the required roll(s) 

 Select the Incident Reported Date Range 

 Click on the Print button. 
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Example of the School Summary-Number of Suspensions Report for WA schools 
 

 
Example of the School Summary-Number of Suspensions Report for NT schools 
 
 
 
 
 
 

18.1.7 School Summary – Number of Times Suspended 

This report presents the school with an overall school view with a Year and Gender breakdown.  
However this report is based on the number of times a student is suspended. 
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This report includes: 

 Student selection - All students, Non-Aboriginal Students, Aboriginal Students 

 Date Range 

 Gender totals – Male, Female 

 Year 

 Number of Times Suspended – 1 to over 4 

 Total for a year and gender group 

 Overall totals for gender group and all selected 
 

 
 
To print the report: 
 

 Enter the Selection option using the radio button (All students is the default) 

 Select the Incident Reported Date Range 

 Click on the Print button 
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Example of the School Summary-Number of Times Suspended Report 
 

Please Note: The “Total” columns are calculated by multiplying the number of times 
suspended to each number in the corresponding row. In the example above 1 Year 10 male 
has been suspended 3 times so a total of 3 suspensions are reported. 

For “>4” suspensions, the actual number of suspensions is multiplied so in the example 
above the Male and Females in Year 10 have both had 5 suspensions recorded. 
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18.1.8 Suspension Status 

This report provides details of those students who are currently on suspension and those who are 
expected to return from suspension for a given date. 
 
The report includes: 

 Name of Students on Suspension for a specified date 

 Name of Students that are returning on the specified date 

 Name of students that were on suspension on the day prior to the specified date 

 Year and Form 

 Suspension Start and Finish Dates for each student 

 Total of Days for the suspension. 
 

 
 

To print the report: 

 Enter Date for Suspension status information 

 Click on the Print button. 
 

 
 
Example of the Suspensions Status Report 
 

Note: This Report includes the names of students whose last day of suspension was the 
previous day to the date selected in the Report window. 
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18.1.9 Detention Statistical Overview 

The objective of the report is to allow the user to obtain analysis on the number of detentions for a 
particular period in the day. 
 

 
 
This report includes: 
 

 Student selection criteria 

 Date Range 

 Student Name 

 Year 

 Form 

 Gender 

 Number of detentions each period per student 

 Total number of detentions over all periods each student 

 Totals for all selected students 

 Row and column totals of the detentions. 
 
To print the report: 
 

 Select the incident reported date range. 
 

Select the Student Selection tab users can select the required students or group. 

 

The options are: 

 Student Find 

 Form 

 Year Group 
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Student Find 

 When the student search option is required uses can access the find tool by clicking on and make 

the Add Students  icon.  

  To delete a particular student selection click on the Remove Students  icon. 

 To delete the student list click on the Remove All Students  icon. 

Form  

To select all forms click on the Select All  icon and this will highlight all forms.  If users wish to 
make a random selection hold down the control key and highlight the required forms  

Year Group  

To select all Year Groups click on the Select All  icon and this will highlight all Year Groups.  If 
users wish to make a random selection hold down the control key and highlight the required Year 
Groups. 

 
 

 Click on the Print button. 
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Example of Detention Statistical Overview Report 

Note: For primary schools using AM/PM, the first two columns will be populated only. 
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18.2 Letters 

Clicking on the Letters folder will display the list of available letters. 
 

 
 
Currently the Suspension Notice –District Office is the only letter available from the Letters folder. 
(Please refer to section 17.10 for details.)  
 
Other letters are available from the Behaviour Management window. (Please refer to section 17 for 
further details.) 
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18.3 Exports 

 
The Exports section under Behaviour > Reports, provides the ability to export in CSV format, a 
Behaviour Analysis Report or a Behaviour Suspension Notification. 
 

18.3.1 Behaviour Analysis Report 

This export feature will generate a CSV format file containing totals for Behaviour types and 
Actions recorded against each student in the browse set over a specified date range.   
 
To create and export the Behaviour Analysis Report: 
 

 Open Behaviour > Reports. 

 Double-click on Exports. 

 Click on Behaviour Analysis. 

 The following window is displayed. 
 

 
 

 The default path for the Export File field will be as defined in the General > Control > 
Preferences > General tab. The default file name is Behaviour.CSV 

 Use the Browse button to select a new Export File path.  Enter a new file name if required. 

 Use the New Query button to select a browse set of students to report on OR select an 
existing query from the Query drop down list. 

 Data will be collated from Behaviour Incidents that fall between the From and Until dates. 
Users can enter the date directly into the date field or use the Date Selector. (For details on 
how the use the Date Selector see section 13.16). 

 Click on Print to generate the CSV export file. 
 
The file can now be emailed from the location as an attachment.  
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To Email the file: 
 

 Check the Email File check box  
 
The following window will be displayed with the file automatically attached: 
 

 
 

 In the To field either type an email address directly in the field  

 Type a subject in the Subject field  

 Click on the Message tab to enter a message 
 

 
 

 Click Send to dispatch the Email. 
 



 
IntegrisBehaviourManual.doc 11-Sep-14 

Page 18-34 

© 2014 Civica Education Pty Ltd 

 

 
Name,RegGroup,Sex,Year,P1,P2,P3,N1,N2,N3,N4,N5,N6,N7,N8,N9,N10,N11,N12,D,I,L,O,R,S 

Jackie Albert,9/9.1,F,9,1,0,2,4,0,0,0,5,0,6,6,0,0,0,0,3,4,2,4,5,4 

Billy Strange,9/9.1,M,9,0,0,0,0,3,4,2,4,0,0,0,3,3,4,2,4,2,4,3,4,2 

Fiona Davidson,9/9.1,F,9,0,0,0,0,0,3,4,2,4,5,0,3,3,4,2,4,2,0,3,0,3 

Jess Victa,9/9.1,F,9,0,0,0,0,0,0,3,4,2,4,5,0,3,3,0,3,3,0,3,0,3 

 
An example of the Behaviour Analysis Report. 
 
If the date range is invalid a warning message will appear. 
 

 
 

18.3.2 Behaviour Suspensions Notification Export 

This export feature will generate a CSV format file containing student suspensions for a set of 
students over a specified date range. The CSV file will automatically be sent to a specified email 
address e.g. Head Office.   
 
The following fields are included in the export file: 
 

Field 

Incident number 

UPN 

Student First Name 

Student Middle Name 

Student Surname 

DOB 

Gender 

Indigenous Status 

Grade 

School Code 

School 

School Type 

Principal   

Teacher 

Year 

Term 

Date of incident 

Reported by 

Suspension Start Date 

Start date Period   

Suspension End date 

End date Period 

Total days suspended 

Place 

Time 

Behaviour Type 

Behaviour Subtype 

Behaviour Subtype 
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additional 

Behaviour Actions 

Notification Details 

Suspension conditions 

Behaviour Details 

Action Details 

Appeal Details 

Appeal Date   

Appeal Status 

SEN Stage 

 

Note: For NT Schools an additional field is included after the SEN Stage. This field is the 
‘Total School Days Suspended’. The data is taken from the ‘Number of School Days’ field on 
the Student Add/Edit window. See section 13.23.6 for further details. 

To create and export the Behaviour Suspensions Notification CSV file: 
 

 Open Behaviour > Reports. 

 Double-click on Exports. 

 Click on Behaviour Suspension Notification. 

 The following window is displayed.  
 

 
 

 The default path for the Export File field will be as defined in the General > Control > 
Preferences > General tab. The default file name is BehSusNot.CSV. 

 Use the Browse button to select a new Export File path.  Enter a new file name if required. 

 Use the New Query button to select a browse set of students to report on OR select an 
existing query from the Query drop down list. 

 Data will be collated from Behaviour Suspensions that fall between the From and Until dates. 
Users can enter the date directly into the date field or use the Date Selector. (For details on 
how the use the Date Selector see section 13.16). 
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 Tick the  checkbox to include suspensions 
received from previous schools that still qualify the selection criteria.  

 Tick the  checkbox to include all behaviour records 
(including suspensions) that still qualify the selection criteria. 

 Click on Print to generate the CSV export file. 
 
The CSV export file will automatically be sent to the email address as defined in Behaviour > 
System Preferences > General > Export Email Address. 
 
If a file already exists in the location the following message will be displayed: 
 

 
 

 Click Yes to overwrite or No to cancel 
 
If Yes is selected the follow message will be displayed: 
 

 
 

 Click OK 
 
The following message will be displayed: 
 

 
 

 Click OK 
 
The file can now be emailed from the location as an attachment.  
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Note: If either of the following error messages is displayed… 

 or  

…please check the email settings at the following three locations; 

1. Export Email address (where you are sending the export too) 

Behaviour > Utilities > System Preferences > Export Email Address 

2. SMTP Server (your mail server that you are using to send the email) 

3. Default from email Address (the email address that it will be sent from) 

General > Control > Preferences > eMail / Web 
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18.4 Custom Reports 

Within the Behaviour Reports users have the option to save reports as a Custom Report.  This 
allows users to tailor and reuse a particular report with the settings and required fields in place. 
The reports that can be saved as a custom report are 
 

 School summary – Number of Suspensions 

 School summary – Number of Times Suspended 

 Suspension status 
 

18.4.1 Saving a Custom Report 

To save a custom report: 
 

  Modify the standard report settings as required. 

 In the Reports window, click on the Save as a Custom Report button.  

 The system displays the Report Title window. By default the name displayed on this window 
will be the name of the report that was used as the template. 

 Enter a name for the modified report. 

 
 

 Click OK. The system saves the new report and places it in the “Custom Reports” folder.  
 

 

Note: this report will only be available to the user who created the custom report and to 
users with system administrator status. To make the report available to all users, see the 
following section of the manual. 

18.4.2 Sharing a Custom Report 

To share the report and make it available to other users 

 Open the Custom Reports folder. 

 Select the custom report to be shared. 

 To share the custom report with other users click on the Allow Custom report to be used by 

others icon  

 If you wish to amend a shared report, edit it and save the changes. The shared access can 
only be removed by deleting the report. 
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18.4.3 Renaming a Custom Report 

To rename a custom report: 
 

 Open the Custom Reports folder. 

 Select the custom report to be renamed. 

 Click on the Rename Custom Report icon . 

 The system places a box around the report name and highlights the current text. 

 Enter the new name for the report. 

 Press <Enter>. 
 

18.4.4 Saving a Report to File 

To save a report to file  

 When the report has been sent to screen Click on the Save icon . The system displays the 
Name of Report File window. 

 Navigate to the location where you want to save the report. 

 Enter a name for your report. 

 Click on OK. The system saves the report in the chosen location. 
 

18.4.5 Deleting a Custom Report 

To delete a custom report 

 Open the Custom Reports folder. 

 Select the custom report you wish to delete.  

 Select the Delete Custom Report icon  on the toolbar. 

 Select Yes to delete. 

Note: the standard reports supplied with the system cannot be deleted. 

18.5 Report Security 

There are three main steps in setting up user access to Behaviour Reports: 
1. Allocate report security access rights to appropriate users; 
2. Set the report security profile; 
3. Activate Report Security. 
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18.5.1 Setting the Report Security Profile  

This function is only available to users who have had access rights allocated in Control > Users. 

 In the Reports window, click the Report Security icon  to open the Report Security 
window.  

            

 
 

The Report Security window has two operating modes: 

 Allocate Reports to Users and; 

 Allocate Users to Reports. 
 
Either mode can be used to allocate report access. 
 
When the window is first opened it is operating in the first of these modes. The operating mode can 
be changed by use of the toolbar buttons at the top of the window. 

   
 
Once the report access profile has been set up as required, clicking OK will save the security 
settings. Alternatively, the Cancel button will close the window without saving your settings. 
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18.5.2 Allocate Reports to Users 

In this operating mode, the left-hand side of the window shows a list of active users in the Integris 
data file. Users with Administrator Status (who have access to all reports) are displayed in bold. 
Only one user from this list may be selected at any one time. 
 

 
 
The right-hand side of the window displays a list of report folders, and a list of the reports present 
in the selected folder. Multiple selections are permitted in this reports list. To select more than one 
report name, hold the <Ctrl> key and click on the report names in the list. Click Grant or Deny to 
change the user’s access. 
 
Ticks and crosses are displayed to indicate whether the selected user has access to a report. 
Double clicking can toggle these. Alternatively, access can be granted or denied to a selection of 
reports at once by selecting several entries in the report list and using the Grant and Deny 
buttons. 
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18.5.3 Allocate Users to Reports 

In this operating mode, the left-hand side of the window shows a list of report folders and a list of 
the reports present in the selected folder. Only one report from this list may be selected at one 
time. 
 

 
 
The right-hand side of the window displays a list of active Integris users. Users with Administrator 
Status are omitted, as they have full access to all reports. Multiple entries may be selected from 
this list. 
 
Ticks and crosses are displayed to indicate whether a user has access to the selected report. 
Double click on a user name to toggle (change) access rights. Alternatively, access can be granted 
or denied to a selection of users at once by selecting several entries in the user list and using the 
Grant and Deny buttons. 
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18.5.4 Activate Report Security  

Once the required access settings for reports have been set up in the Report Security window, 
Report Security can be activated (If it has not already been done).  This is achieved by ticking the 
Report Security Active checkbox in the Preferences window (General > Control > Preferences > 
Security tab). See the screen shot below. 
 

 
 

When Report Security is active, the following banner will be displayed in the Reports window if a 
user attempts to select a report to which they do not have access. 
 

 
 
Users who have Administrator Status automatically have access to all reports. By default, Report 
Security is inactive in a new or upgraded data files.  
 

18.5.5 Custom Report Security 

Custom reports are only included in the Report Security system if they are shared. Unshared 
reports are only available to the user who created them, whereas shared reports are visible to all 
users in the system. Shared custom reports are initially only accessible by their creator and users 
with Administrator Status 
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20 Support  

20.1 WA 

Should you require support please contact the Customer Service Centre (CSC) at the Department 
of Education. 
 
Contact details below: 
 

Phone (CSC) 

Metro:   9264 5555 
Country:  1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 
 

Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 
 

20.2 NT 

Should you require support please contact the following: 

DEET SAMS Support  

Email  sams.deet@nt.gov.au 
Or Call DEET Hotline 8999 3531 
Or Fax SAMS/DEET 89995611 
Or Web Site  http://www.latis.net.au/sams/ 
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